
 

 

第    章 

ABAQUS 的基本模块和操作方法 

本章将详细介绍 ABAQUS 进行有限元分析的步骤及 ABAQUS/CAE 的各模块，帮助读

者掌握 ABAQUS/CAE 强大的建模和网格划分功能。 
在应用 ABAQUS 进行有限元分析时，通常都要经历 3 个分析步，即前处理（ABAQUS/ 

CAE）、分析计算（ABAQUS/Standard 或 ABAQUS/Explicit）及后处理（ABAQUS/View）。

在 ABAQUS/CAE 中主要用到 10 个模块，分别是草图模块、部件模块、属性模块、装配模

块、分析步模块、载荷模块、相互作用模块、网格模块、分析作业模块和可视化模块。 
 掌握 ABAQUS 进行有限元分析的步骤及各模块功能 

 掌握 ABAQUS/CAE 强大的建模和网格划分功能 

 

任务驱动&项目案例 
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2.1  ABAQUS 分析步骤 

前处理、分析计算和后处理是有限元分析的 3 个步骤。这 3 个步骤在 ABAQUS 中的实现方法介

绍如下。 

2.1.1  前处理（ABAQUS/CAE） 

前处理阶段的中心任务是定义物理问题的模型，并生成相应的 ABAQUS 输入文件。ABAQUS/CAE
是完整的 ABAQUS 运行环境，可以生成 ABAQUS 的模型，使用交互式的界面提交和监控分析作业，

最后显示分析结果。ABAQUS/CAE 分为若干个模块，每个模块都用于完成模拟过程中的一个方面的

工作，例如定义几何形状、材料性质、载荷和边界条件等。建模完成之后，ABAQUS/CAE 可以生成

ABAQUS 输入文件，提交给 ABAQUS/Standard 或 ABAQUS/Explicit。 
读者也可以使用其他的前处理器，如 MSC.PATRAN、Hypermesh 等来创建模型，但是 ABAQUS

的很多功能（如定义面、接触对、连接器等）只有 ABAQUS/CAE 才支持。因而建议读者使用

ABAQUS/CAE 作为前处理器。 

2.1.2  分析计算（ABAQUS/Standard 或 ABAQUS/Explicit） 

在这个阶段中，使用 ABAQUS/Standard 或者 ABAQUS/Explicit 求解输入文件中所定义的数值模

型，计算过程通常在后台运行，分析结果以二进制的形式保存起来，以用于后处理过程。完成一个求

解过程所花费的时间由问题的复杂程度和计算机的计算能力等因素决定。 

2.1.3  后处理（ABAQUS/Viewer） 

ABAQUS/CAE 的后处理部分又叫作 ABAQUS/Viewer，可以用来读入分析结果数据，以多种方

法显示分析结果，包括动画、彩色云纹图、变形图和 XY 曲线图等。 

2.2  ABAQUS/CAE 的模块 

一般来说，首先在 Part 模块中创建部件（有时需要与 Assembly 模块配合使用），之后在 Assembly
模块中进行部件的装配。 

ABAQUS 可以在装配件和分析步的基础上，在 Interaction（相互作用）模块中定义相互作用、约

束或连接器以及在 Load（载荷）模块中定义载荷、边界条件、预定义场等，这两个模块通常没有先

后顺序的要求。 
在进入 Interaction 模块和 Load 模块之前的任何时候，都可以在分析步模块中定义分析步和变量

输出要求；在创建 Part 模块后，创建 Job（作业）模块之前的任何时候，都可以进入 Property（属性）

模块进行材料和截面属性的设置。 
如果在 Assembly 模块中创建的是非独立实体，则用户可以在创建 Part 模块后，创建 Job 模块之

前的任何时候，在 Mesh 模块中对部件进行网格划分；如果在 Assembly 模块中创建的是独立实体，
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则用户可以在创建 Assembly 模块后，创建 Job 模块之前的任何时候，在 Mesh 模块中对装配件进行网

格划分。 

2.3  部件模块和草图模块 

启动 ABAQUS，界面中出现 ABAQUS 的第一个模块—部件模块，部件模块提供了强大的建模

功能，支持两种建模方式：在 ABAQUS/CAE 中直接建模和从其他软件中导入模型。 

2.3.1  创建部件 

执行 Part→Create（创建）命令，或者单击工具区（见图 2-1）中的 Create Part（创建部件）图标 ，

将会弹出 Create Part 对话框，如图 2-2 所示。 

                      
                 图 2-1  工具区                       图 2-2  Create Part 对话框 

在弹出的 Create Part 对话框中，可以选择调整的名称和大约尺寸（其单位与模型的单位一致）选

项，其默认值分别为“Part-n”（n 表示创建的第 n 个部件）和 200。其他选项均为单选按钮。 
设置完成图 2-2 中的对话框选项之后，单击 Continue（继续）按钮，进入绘制平面草图的界面，

如图 2-3 所示。使用界面左侧工具区中的工具，可以做出点、线、面，作为构成部件的要素（此处不

再详细介绍，具体操作读者可通过相关的例子掌握）。 
部件创建完成后，单击工具区中的部件管理器工具，弹出 Part Manager（部件管理器）对话框（见

图 2-4），其中列出了模型中的所有部件，包括 Create、Copy（复制）、Rename（重命名）、Delete（删

除）、Lock（锁定）、Unlock（解锁）、Update Validity（更新有效性）、Ignore Invalidity（忽略无效性）

和 Dismiss（撤销）按钮。 
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图 2-3  绘制平面草图的界面 

 
图 2-4  Part Manager 对话框 

2.3.2  部件的外导入 

可以把建立好的模型导入 ABAQUS 中，导入分为以下两种情况。 
 导入在其他 CAD 软件中建立的模型。 
 导入 ABAQUS 建立后导出的模型。 
ABAQUS 2020 提供了强大的接口，支持草图、部件、装配件和模型的导入，模型导入菜单如     

图 2-5 所示。对于每种类型的导入，ABAQUS 2020 都支持多种不同后缀名的文件，但导入的方法和
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步骤是类似的。另外，ABAQUS 还支持草图、部件、装配和 VRML（当前视窗的模型导出成 VRML
文件）等的导出，如图 2-6 所示。 

             
                图 2-5  模型导入菜单                           图 2-6  模型导出菜单 

2.3.3  问题模型的修复与修改 

1．修复 

有些模型在之后的操作中可能会遇到问题，这时需要仔细阅读警告提示的内容，然后单击 Cancel
（取消）按钮。 

如果出现了警告，则需要对导入的模型进行修复。执行 Tools（工具）→Geometry Edit（几何编

辑）命令，弹出 Geometry Edit（几何编辑）对话框，如图 2-7 所示，在 Category（类别）选项组中选

择需要修复的区域，有 3 个选项可以选择，分别是 Edge（边）、Face（表面）和 Part。 

 
图 2-7  Geometry Edit 对话框 

 提示：几何修复结束后，可以查看模型，具体操作为：单击工具栏中的 Query Information（询问信

息）按钮 询问信息 ，弹出 Query（询问）对话框，如图 2-8 所示。 
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图 2-8  Query 对话框 

2．修改 

在创建或导入一个部件后，可以使用如图 2-9 所示的工具对此部件做一定的修改，实现添加或者

切除模型的一部分，以及倒角等功能。 

                        
              （a）实体工具                    （b）线工具               （c）倒角工具 

                   
             （d）壳工具                     （e）剪切工具                 （f）镜像工具  

图 2-9  修改工具 

2.4  属 性 模 块 

在模块列表中选择 Property，即进入属性模块，在此模块中可以进行材料和截面特性的设置以及

弹簧、阻尼器和实体表面壳的定义等。可以发现菜单栏有所变化，如图 2-10 所示，同时工具区转变

成与设置材料和截面特性相对应的工具，如图 2-11 所示。 
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图 2-10  属性模块的菜单栏                    图 2-11  属性模块的工具区 

2.4.1  材料属性 

执行 Material（材料）→Create 命令，或单击工具区中的 Create Material（创建材料）图标 ，弹

出 Edit Material（编辑材料）对话框，如图 2-12 所示。该对话框包括 3 个部分。 

 
图 2-12  Edit Material 对话框 
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 Name（名称）：用于为材料命名。 
 Description（描述）：出现在材料行为的上方，在该区域内设置相应的材料参数值。 
 Material Behaviors（材料行为）：用于选择材料类型。 

2.4.2  截面特性 

ABAQUS/CAE 不能直接把材料属性赋予模型，而是先创建包含材料属性的截面特性，再将截面

特性分配给模型的各区域。 

1．创建截面特性 

单击工具区中的 Create Section（创建截面）图标 ，弹出如     
图 2-13 所示的 Create Section 对话框。该对话框包括两个部分。 

 Name：定义截面的名称。 
 Category 和 Type（类型）：共同决定截面的类型。 

2．分配截面特性 

创建了截面特性后，就要将它分配给模型。 
首先，在环境栏的部件列表中选择要赋予截面特性的部件，如

图 2-14 所示，然后单击工具区中的 Assign Section（指派截面）图

标 ，或执行 Assign（指派）→Section 命令，按提示在视图区选择要赋予此截面特性的部分，单击

提示区的 Done（完成）按钮，弹出 Edit Section Assignment（编辑截面指派）对话框，如图 2-15 所示。 

        
             图 2-14  在环境栏的部件列表中选择部件             图 2-15  Edit Section Assignment 对话框 

如果在准备分配截面特性时，发现需要单独分配截面特性的部分没有分离出来，可以在工具区中

的分割工具栏中选用适当的工具进行部件的分割，如图 2-16 所示。 
单击工具区中的 Section Assignment Manager（截面指派管理器）图标 ，该管理器中显示已分配

的截面列表，如图 2-17 所示。 

                            
图 2-16  工具区中的分割工具栏                 图 2-17  Section Assignment Manager 对话框 

图 2-13  Create Section 对话框
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2.4.3  梁的界面特性 

ABAQUS 还可以在属性模块中定义梁的截面特性、截面方向和

切向方向。 

1．梁的截面特性 

梁的截面特性的设置方法与其他截面类型有所差异，主要体现

在以下方面。 
 在创建梁的截面特性前，需要首先定义梁的横截面的形状

和尺寸，单击工具区中的 Create Profile（创建轮廓）图标 ，

弹出 Create Profile 对话框，如图 2-18 所示。以 Box 为例，

单击 Continue 按钮，进入 Edit Profile（编辑轮廓）对话框，

如图 2-19 所示。 
 当选择在分析前提供截面特性时，材料属性在 Edit Beam 

Section（编辑梁截面）对话框（见图 2-20）中定义，不需要通过创建材料工具创建材料。 

      
              图 2-19  Edit Profile 对话框                     图 2-20  Edit Beam Section 对话框 

2．梁的截面方向和切向方向 

在分析前，还需要定义梁的截面方向，方法如下。 
执行 Assign→Beam Section Orientation（梁截面方向）命令，或单击工具区中的 Assign Beam 

Orientation（指派梁方向）图标 ，在视图区选择要定义截面方向的梁，单击鼠标中键，在提示区中

输入梁截面的局部坐标的 1 方向（见图 2-21），按 Enter 键，再单击提示区的 Done 按钮，完成梁截面

方向的设置。 

 
图 2-21  输入梁截面的局部坐标的 1 方向 

当部件由线组成时，ABAQUS 会为其指定默认的切向方向，但可以改变此默认的切向方向。 

 
图 2-18  Create Profile 对话框
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 提示：在菜单栏上执行 Assign→Element Tangent（单元切向）命令，或按住 Assign Beam Orientation
（指派梁方向）图标 ，在展开的工具条中选择 Assign Beam/Truss Tangent（指派梁/桁架切

向）图标 ，在视图区选择要改变切向方向的梁，单击提示区的 Done 按钮，梁的切向方向

即变为反方向。此时，梁截面的局部坐标的 2 方向也变为反方向。 

2.4.4  特殊设置 

1．惯量 

用户可以定义各种惯量，执行 Special（特殊设置）→Inertia（惯量）→Create 命令，弹出 Create Inertia
（创建惯量）对话框（见图 2-22），在 Name 文本框中输入名称，在 Type 选项组中可以选择 Point 
mass/inertia（点质量/惯性）、Nonstructural mass（非结构质量）和 Heat capacitance（热电容）选项，

单击 Continue 按钮，在视图区选择对象进行相应惯量的设置。 

 
图 2-22  定义惯量 

2．蒙皮 

在属性模块中，用户可以在实体模型的面或轴对称模型的边附上一层皮肤，适用于几何部件和网

格部件。 

 提示：蒙皮的材料可以不同于其下部件的材料。蒙皮的截面类型可以是均匀壳截面、膜、复合壳截

面、表面和垫圈。执行 Special→Skin（皮肤）→Create 命令创建蒙皮。 
 

 提示：一般情况下，用户不方便直接从模型中选择蒙皮，这时可以使用集合工具，方法为执行 Tools→
Set（集合）→Create 命令，在弹出的 Create Set（创建集合）对话框（见图 2-23）中，输入

名称，单击 Continue 按钮，在视图区中选择蒙皮作为构成集合的元素，单击提示区的 Done
按钮，完成集合的定义。 

 
图 2-23  Create Set 对话框 
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单击 Display Group（显示组）工具栏中的 Create Display Group（创建显示组）图标 ，弹出 Create 
Display Group 对话框，在 Item（项）选项组中选择集，在其右侧的区域内选择包含蒙皮的集合，如

图 2-24 所示，单击对话框下端的 Intersect（交集）按钮，视图区即显示定义的蒙皮。 

  
图 2-24  Create Display Group 对话框   

对于实体和轴对称部件，在网格模块中对部件进行网格划分时，ABAQUS 会自动对位于表面的

蒙皮划分对应的网格，而不用单独对蒙皮进行网格划分。 

3．弹簧/阻尼器 

ABAQUS 可以定义各种惯量，执行 Special→Springs/Dashpots（弹簧/阻尼）→Create 命令，弹出

Create Springs/Dashpots 对话框（见图 2-25），在 Name 文本框中输入名称，在 Connectivity Type（连

接类型）选项组中可以选择 Connect two points（连接两点）和 Connect points to ground (Standard)（一

点接地）选项，后者仅适用于 ABAQUS/Standard。 

 
图 2-25  Create Springs/Dashpots 对话框 
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单击 Continue 按钮，在视图区选择对象进行相应的设置，单击提示区的 Done 按钮。用户可以在

弹出的 Edit Springs/Dashpots 对话框（见图 2-26）中，同时设置弹簧的刚度和阻尼器系数。 

         
（a）连接两点                         （b）一点接地 

图 2-26  Edit Springs/Dashpots 对话框 

2.5  装 配 模 块 

在模块列表中选择装配，即进入装配模块。在部件模块中创建或导入部件时，整个过程都是在局

部坐标系下进行的。对于由多个部件构成的物体，必须将其在统一的整体坐标系中进行装配，使之成

为一个整体，这部分工作需要在装配模块中进行。 

 提示：一个模型只能包含一个装配体，一个装配体可以包含多个部件，一个部件也可以被多次调

用来组装成装配件。即使装配件中只包含一个部件，也必须进行装配，定义载荷、边界条

件、相互作用等操作都必须在装配件的基础上进行。 

2.5.1  部件实体的创建 

装配的第一步是选择装配的部件，创建部件实体。具体操作方法是执行 Instance（实体）→Create
命令，或单击工具区中的 Create Instance（将部件实体化）图标 ，弹出 Create Instance 对话框。 

该对话框包含 3 部分，其中部件选项组内列出了所有存在的部件，单击鼠标左键进行部件的选择，

可以单选，也可以多选，多选则要借助 Shift 键或 Ctrl 键进行单击。 
实体类型选项组用于选择创建实体的类型，包含以下两个选项。 
 Dependent(mesh on part)：用于创建非独立的部件实体，为默认选项。当对部件划分网格时，

相同的网格被添加到调用该部件的所有实体中，特别适用于线性阵列和辐射阵列构建部件

实体。 
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 Independent(mesh on instance)：用于创建独立的部件实体，这种实体是对原始部件的复制。

此时，用户需要对装配件中的每个实体划分网格，而不是原始部件。此外，Auto-offset from 
other instances 选项用于使实体间产生偏移而不重叠。 

最后，单击 OK 按钮，完成实体的创建。 
工具区和菜单栏中没有删除实体等工具，创建部件实体后，可

以在模型树中进行这些操作，具体操作为：在模型树中单击该模型

装配前的 按钮展开该列表，再单击实例前的 按钮，鼠标指向需要

操作的实体，单击鼠标右键，在弹出的快捷菜单中选择 Delete 命令

删除该实体（见图 2-27），Suppress（抑制）或 Resume（恢复）命令

分别用于抑制和恢复该实体的选择。 
部件实体创建完成后，其实体类型可以修改，方法为在模型树

中选择该部件实体，单击鼠标右键，在弹出的快捷菜单（见图 2-27）
中选择 Make Independent 或 Make Dependent 命令，即可改变实体的

类型。 
ABAQUS/CAE 还可以阵列形式复制部件实体，包含线性阵列和

环形阵列两种模式，分别介绍如下。 

1．线性阵列模式 

执行 Instance→Linear Pattern（线性阵列）命令，或单击工具区中的 Linear Pattern 图标 ，在视

图区单击鼠标左键选择实体，单击提示区的 Done 按钮，弹出 Linear Pattern 对话框，如图 2-28（a）
所示。该对话框包括如下几个选项。 

 Direction 1（方向 1）选项组：用于设置线性阵列的第一个方向，默认为 X 轴。 
 Direction 2（方向 2）选项组：用于设置线性阵列的第二个方向，默认为 Y 轴。 
 Preview（预览）复选框：用于预览线性阵列的实体，默认为选择预览方式。 
完成设置后，单击 OK 按钮，完成线性阵列的实体创建操作。 

2．环形阵列模式 

执行 Instance→Radial Pattern（环形阵列）命令，或单击工具区中的 Radial Pattern 图标 ，在视

图区单击鼠标左键选择实体，单击提示区的 Done 按钮，弹出 Radial Pattern 对话框，如图 2-28（b）所

示。其选项与线性阵列模式类似，不再赘述。 

           
（a）Linear Pattern 对话框       （b）Radial Pattern 对话框   

图 2-28  Linear Pattern 和 Radial Pattern 对话框 

图 2-27  快捷菜单 
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2.5.2  部件实体的定位 

创建了部件实体后，可以采用多种工具对实体进行定位，下面分别进行介绍。 

1．平移和旋转工具 

使用平移和旋转工具可以完成部件实体在任何情况下的定位，常用工具有平移、旋转、平移到。

下面分别对这些工具进行介绍。 
（1）平移 
执行 Instance→Translate（平移）命令，或单击工具区中的 Translate Instance（平移实例）图标 ，

在视图区单击鼠标左键选择实体，单击提示区的 Done 按钮。 
有两种方法实现部件实体的平移。 
 按提示输入平移向量起点的坐标（见图 2-29），按 Enter 键。继续在提示区输入平移向量终

点的坐标（见图 2-30），再次按 Enter 键。 

 
图 2-29  输入平移向量起始点的坐标 

 
图 2-30  输入平移向量终点的坐标 

 在视图区中选择部件实体上的一点，接着在视图区中选择部件实体上的另一点。此时，视

图区中显示出实体移动后的位置，单击 OK 按钮，完成部件实体移动。 
（2）旋转 
执行 Instance→Rotate（旋转）命令，或单击工具区中的 Rotate Instance（旋转实例）图标 ，单

击要旋转的部件，单击鼠标中键，此时，提示输入旋转轴的起始坐标，输入后单击鼠标中键，提示输

入旋转轴的终点坐标，输入后单击鼠标中键，提示输入旋转角度，如图 2-31～图 2-33 所示。 

 
图 2-31  输入旋转轴的起始坐标 

 
图 2-32  输入旋转轴的终点坐标 

 
图 2-33  输入旋转角度 

（3）平移到 
执行 Instance→Translate to（平移到）命令，或单击工具区中的 Translate to（平移到）图标 ，在

视图区单击鼠标左键选择移动实体的边（二维或轴对称实体）或面（三维实体），单击提示区的 Done
按钮，再选择固定实体的面或边，单击提示区的 Done 按钮。类似于平移工具，选择平移向量的起止点。 

之后，需要在提示区输入移动后两实体的间隙距离，负值表示两实体的重叠距离，默认为 0.0，
即选择的两实体的面或边接触在一起，单击 Done 按钮，确认本次操作。 

2．约束定位工具 

ABAQUS/CAE 提供了一系列约束定位工具，包括在约束菜单和展开工具条 中，或打

开菜单栏中的 Constraint（约束）菜单，如图 2-34 所示。 
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 提示：这组工具与平移工具类似，都是通过指定两个部件实体间的位置关系来移动其中一个实体；

不同的是约束定位操作可以撤销和修改。 

在模型树中选择 Assembly→Position Constraints（位置约束）节点，选择已经定义好的位移约束类

型后单击鼠标右键，在弹出的快捷菜单中选择 Delete 命令（见图 2-35）删除该约束定位操作，Suppress
或 Resume 命令用于抑制和恢复该约束定位操作。 

双击已经定义好的位置约束类型，ABAQUS 会弹出如图 2-36 所示的 Edit Feature（编辑功能）对

话框，对已经定义好的约束类型进行确认和修改。 

                  
 图 2-34  约束菜单列表            图 2-35  命令菜单              图 2-36  Edit Feature 对话框 

 提示：单独的约束定位操作很难对部件实体进行精确定位，往往需要几个约束定位操作的配合才

能精确地定位部件实体。 

2.5.3  合并/切割部件实体 

当装配件包含两个或两个以上的部件实体时，ABAQUS/CAE 提供部件实体的合并和剪切功能。

对选择的实体进行合并或剪切操作后，将产生一个新的实体和一个新的部件。 
具体操作为：执行 Instance→Merge/Cut（合并/切割）命令，或单击工具区中的 Merge/Cut Instance

（合并/切割实体）图标 ，弹出 Merge/Cut Instances 对话框，如图 2-37 所示。 

             
                   （a）合并几何实体                        （b）合并网格实体 

图 2-37  Merge/Cut Instances 对话框 
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Merge/Cut Instances 对话框中各选项含义如下。 
 Part name（部件名称）：用于输入新生成的部件的名称。 
 Operations（操作）：用于选择操作的类型。 
 Merge（合并）：用于部件实体的合并。 
 Cut geometry（切割）：用于部件实体的剪切，仅适用于几何部件实体。 
 Options（选项）：用于设置操作的选项。 
 Mesh：用于选择结点的合并方式，适用于带有网格的实体，如图 2-37（b）所示。 
 Tolerance（容差）：用于输入合并结点间的最大距离，默认值为 1×10-6，即间距在 1×10-6内

的结点被合并，适用于带有网格的实体，如图 2-37（b）所示。 
设置完 Merge/Cut Instance 对话框后，单击 Continue 按钮，视图区选择需要操作的实体，单击提

示区的 Done 按钮，ABAQUS/CAE 进行合并或切割运算。 

2.6  分析步模块 

任何几何模型都可在前面介绍的 4 个模块中创建。部件模块和草图模块用于创建部件，装配模块

用于组装模型的各部件。有时，需要将部件模块和装配模块配合起来使用（如通过装配模块中的合并

和切割功能创建出新的部件，再进行装配）。 
对装配件中所包含的部件的所有操作都完成后，就可以进入分析步模块，进行分析步和输出的  

定义。 

2.6.1  设置分析步 

进入分析步模块后，菜单栏中的分析步菜单及工具区中的创建分析步工具和分析步管理器工具用

于分析步的创建和管理。 

 提示：创建一个模型数据库后，ABAQUS/CAE 默认创建初始步（Initial），位于所有分析步之前。

用户可以在初始步中设置边界条件和相互作用，使之在整个分析中起作用，但不能编辑、

替换、重命名和删除初始步。 

ABAQUS 可以在初始步后创建一个或多个分析步，执行 Step（分析

步）→Create 命令，如图 2-38 所示；或单击工具区中的 Create Step（创

建分析步）图标 ，弹出 Create Step 对话框，如图 2-39 所示。 
该对话框包括以下 3 个部分。 
 Name：在该文本框中输入分析步的名称，默认为“Step-n”（n

表示创建的第 n 个分析步）。 
 Insert new step after：在选定项目后插入新的分析步，用于设置

创建的分析步的位置，每个新创建的分析步都可以设置在初始

步后的任何位置。 
 Procedure type：分析步类型，用于选择分析步的类型。需要首先选择 General（通用）分析

步或 Linear perturbation（线性摄动）分析步，下方列表中显示出所有可供选择的分析步类

型，默认为通用分析步中的 Static,General 选项。 
 General 分析步：用于设置一个通用分析步，可用于线性分析和非线性分析。该分析步

 
图 2-38  创建分析步命令
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定义了一个连续的事件，即前一个通用分析步的结束是后一个通用分析步的开始。 
 Linear perturbation 分析步：用于设置一个线性摄动分析步，仅适用于 ABAQUS/Standard

中的线性分析。 
选择分析类型后，单击 Continue 按钮，弹出 Edit Step（编辑分析步）对话框。对于不同类型的分

析步，该对话框的选项有所差异。下面就几种常用的分析步进行介绍。 

1．Static,General 分析步 

该分析步用于分析线性或非线性静力学问题。其 Edit Step 对话框包括 Basic（基本信息）、

Incrementation（增量）和 Other（其他）3 个选项卡。 
（1）Basic 选项卡 
该选项卡主要用于设置分析步的时间和几何非线性等属性，如图 2-40 所示。 

      
      图 2-39  Create Step 对话框                         图 2-40  Basic 选项卡  

 Description：用于输入对该分析步的简单描述，该描述保存在结果数据库中，进入可视化模

块后显示在状态区。 
 Time period（时间长度）：用于输入该分析步的时间，系统默认值为 l。对于一般的静力学问

题，可以采用默认值。 
 Nlgeom（几何非线性）：用于选择该分析步是否考虑几何非线性，对于 ABAQUS/Standard

该选项默认为 off。 
 Automatic stabilization（自动稳定）：用于局部不稳定的问题（如表面褶皱、局部屈曲），

ABAQUS/Standard 会施加阻尼来使其变得稳定。 
 Include adiabatic heating effects（包括绝热效应）：用于绝热的应力分析，如高速加工过程。 
（2）Incrementation 选项卡 
该选项卡用于设置增量步，如图 2-41 所示。 
 Type：用于选择时间增量的控制方法。 
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图 2-41  Incrementation 选项卡 

 Maximum number of increments（最大增量步数）：用于设置该分析步的增量步数目的上限，

默认值为 100。即使没有完成分析，当增量步的数目达到该值时，分析也会停止。 
 Increment size（增量大小）：用于设置增量步的大小。 
（3）Other 选项卡 
该选项卡用于选择求解器、求解技术，载荷随时间的变化方式等，如图 2-42 所示。 

 
图 2-42  Other 选项卡 

 Equation Solver（求解器）：不包括接触迭代方法。 
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 Default load variation with time（默认的载荷随时间的变化方式）：默认选项为瞬间加载。 
 Extrapolation of previous state at start of each increment（每一增量步开始时外推前一状态）：

适用于分析步开始时载荷不突然变化的情况。 
ABAQUS/Standard 在分析步开始时不计算初始加速度。 

2．Dynamic,Implicit 分析步 

该分析步用于分析线性或非线性隐式动力学分析问题，其 Edit Step 对话框（见图 2-43）也包括

Basic、Incrementation 和 Other 3 个选项卡，其中很多选项与静力学分析时相同，此处仅介绍不同的选项。 

 
图 2-43  Edit Step 对话框 

在 Incrementation 选项卡中，当选中 Automatic（自动时间增量）单选按钮时，可以设置增量步中

的平衡残余误差的容差。 
当选中 Fixed（固定时间增量）单选按钮时，可以选中 Suppress calculation（禁用计算）复选框来

加快收敛。 
若前一个分析步也是动力学分析步，采用前一个分析步结束时的加速度作为新的分析步的加速

度；若当前分析步是第一个动力学分析步，加速度为 0。在默认情况下，ABAQUS/Standard 计算初始

加速度。 

3．Dynamic,Explicit 分析步 

该分析步用于显式动力学分析，除 Basic、Incrementation 和 Other 3 个选项卡外，Edit Step 对话

框中还包括一个 Mass scaling（质量缩放）选项卡。Basic 选项卡中的几何非线性选项默认为 on。 
 Use scaled mass and “throughout step”definitions from the previous step（使用前一分析步的缩

放质量和范围定义）：为默认选项，程序采用前一个分析步对质量缩放的定义。 
 Use scaling definitions below（使用下面的缩放定义）：用于创建一个或多个质量缩放定义。

选中此单选按钮，单击该对话框下部的 Create 按钮，弹出 Edit Mass Scaling（编辑质量缩放）

对话框（见图 2-44），在该对话框中选择质量缩放的类型并进行相应的设置。 
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设置完成后，Edit Step 对话框的数据列表内将显示出该质量缩放的设置，用户可以单击该对话框

下部的 Edit（编辑）或 Delete 按钮进行质量缩放定义的编辑或删除，如图 2-45 所示。 

     
      图 2-44  Edit Mass Scaling 对话框                     图 2-45  Edit Step 对话框 

Other 选项卡页面与 Static,General 和 Dynamic,Implicit 分析步的情况不同，仅包含以下两个文本

框，如图 2-46 所示。 

  
图 2-46  Other 选项卡 

 Linear bulk viscosity parameter（线性体积黏度参数）：用于输入线性体积黏度参数，默认值

为 0.06，ABAQUS/Explicit 默认使用该类参数。 
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 Quadratic bulk viscosity parameter（二次体积黏度参数）：用于输入二次体积黏度参数，默认

值为 1.2。 

4．Static,Linear perturbation 分析步 

该分析步用于线性静力学分析，其 Edit Step 对话框仅包含 Basic 和 Other 两个选项卡（见图 2-47），
且选项为 Static,General 的子集。 

 
图 2-47  Edit Step 对话框 

（1）Basic 选项卡：包含 Description 文本框。Nlgeom 为 off，即不涉及几何非线性问题。 
（2）Other 选项卡：仅包含 Equation Solver 选项组，如图 2-48 所示。 

 
图 2-48  Other 选项卡 
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设置完成后，单击 OK 按钮，完成分析步的创建。 
此时单击工具区中的 Step Manager（分析步管理器）图标 ，可见对话框中列出了初始步和已创

建的分析步，可以对列出的分析步进行编辑、替换、重命名、删除操作和几何非线性的选择，如       
图 2-49 所示。 

 
图 2-49  Step Manager 对话框 

2.6.2  定义场输出和历史输出 

用户可以设置写入输出数据库的变量，包括场变量（以较低的频率将整个模型或模型的大部分区

域的结果写入输出数据库）和历史变量（以较高的频率将模型的小部分区域的结果写入输出数据库）。 

1．场输出和历史输出要求管理器 

创建了分析步后，ABAQUS/CAE 会自动创建默认的场输出要求和历史输出要求（线性摄动分析

步中的屈曲、频率、复数频率无历史变量输出）。 
单击工具区中的 Field Output Manager（场输出管理器）和 History Output Manager（历史输出管

理器）图标 ，分别弹出 Field Output Requests Manager（场输出要求管理器）和 History Output Requests 
Manager（历史输出要求管理器）对话框，如图 2-50 所示。 

    
（a）Field Output Requests Manager 对话框           （b）History Output Requests Manager 对话框     

图 2-50  场输出和历史输出要求管理器 

ABAQUS 可以在输出要求管理器中进行场输出和历史输出要求的创建、重命名、复制、删除、

编辑操作。此外，列表最左侧的 表示该场输出和历史输出要求被激活，单击此图标则变为 ，表示

该场输出和历史输出要求被抑制。已创建的通用分析步的场输出和历史输出要求，在之后所有的通用

分析步中继续起作用，在管理器中显示为传递，该功能同样适用于线性摄动分析步，但必须是同一种

线性摄动分析步的场输出和历史输出要求。 

2．场输出和历史输出的编辑 

单击 Field Output Requests Manager 或 History Output Requests Manager 对话框中的 Edit 按钮，弹

出 Edit Field Output Request 或 Edit History Output Request 对话框，如图 2-51 所示，就可以对 Field 
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Output Request 或 History Output Request 进行修改。 

      
        （a）Edit Field Output Request 对话框              （b）Edit History Output Request 对话框 

图 2-51  场输出和历史输出的编辑 

2.7  载 荷 模 块 

2.7.1  载荷的定义 

进入 Load 模块后，菜单栏中的 Load 及工具区中的创建载荷

工具 和载荷管理器工具 用于载荷的创建和管理。 
定义载荷时，执行 Load→Create 命令，或单击工具区中的

Create Load（创建载荷）图标 ，也可双击左侧模型树中的载荷，

弹出 Create Load 对话框，如图 2-52 所示。 
该对话框包括如下常用选项。 
 Name：在该文本框中输入载荷的名称，默认为“Load-n”

（n 为创建的第 n 个载荷）。 
 Step：用于选择用于创建载荷的分析步。 
 Category：用于选择适用于所选分析步的加载种类。 

 Mechanical（力学）：该选项中包括集中力、弯矩、

压强、表面载荷、壳的边载荷、管道压力、线载荷、 图 2-52  Create Load 对话框 
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体力、重力、指定方向的加速度、广义平面应变、旋转体力、螺栓或扣件的预紧力、

科氏力、施加在连接器上的集中力、惯性释放载荷、施加在连接器上的力矩等。 
 Thermal（热学）：该选项中包括表面热流、体热通量、集中热通量。 
 Acoustic（声学）：该选项可设置向内体积加速度。 
 Fluid（流体）：该选项中包括流体参考压力。 
 Electrical/Magnetic（电磁学）：该选项中包括 Static,General 分析步中的集中电荷、表面

电荷、体电荷；热-电耦合分析中的表面电流、集中电流、体电流。 
 Types for Selected Step（可用于所选分析步的类型）：用于选择载荷的类型，是 Category 的

下级选项。对于不同的分析步，可以施加不同的载荷种类。 

2.7.2  边界条件的定义 

菜单栏中的 Boundary Condition（边界条件）及工具区中的 Create Boundary Condition（创建边界

条件）图标 和 Boundary Condition Manager（边界条件管理器）图标 用于边界条件的创建和管理。 
定义边界条件时，单击工具区中的 Create Boundary Condition 图标 ，或执行 Boundary Condition

→Create 命令，也可双击左侧模型树中的边界条件，弹出 Create Boundary Condition 对话框，如图 2-53
所示。该对话框与 Create Load 对话框类似，包括以下几个部分。 

 Name：在该文本框中输入边界条件的名称，默认为“BC-n”（n 为创建的第 n 个边界条件）。 
 Step：在该下拉列表框中选择用于创建边界条件的步骤，包括初始步和分析步。 
 Category：用于选择适用于所选步骤的边界条件种类。 

 Mechanical：包括对称/反对称/完全固定、位移/转角、速度/角速度、连接位移、连接速

度，如图 2-53（a）所示。 
 Electrical/Magnetic：包括电势。 
 Other：包括流体气蚀区压力，连接物质流动和子模型，如图 2-53（b）所示。 

       
                   （a）力学类别                              （b）其他类别 

图 2-53  Create Boundary Condition 对话框 

 Types for Selected Step（可用于所选分析步的类型）：用于选择边界条件的类型，是类别的下

一级选项。对于不同的分析步，可以施加不同的边界条件类型。 
下面对较常用的 Symmetry/Antisymmetry/Encastre（对称/反对称/完全固定）和 Displacement/ 
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Rotation（位移/转角）边界条件的定义做简要介绍，其他选项请读者参阅系统帮助文件“ABAQUS/CAE 
User’s Manual”。 

1．定义对称/反对称/完全固定边界条件 

如图 2-53（a）所示，选择 Symmetry/Antisymmetry/Encastre 选项后，单击 Continue 按钮，选择施

加该边界条件的 Point（点）、Line（线）、Surface（面）、Cells（单元），单击提示区的 Done 按钮，弹

出 Edit Boundary Condition（编辑边界条件）对话框，如图 2-54 所示。 

 
图 2-54  Edit Boundary Condition 对话框 

该对话框包括以下 8 种单选的边界条件。 
 XSYMM：关于与 X 轴（坐标轴 1）垂直的平面对称（U1=UR2=UR3=0）。 
 YSYMM：关于与 Y 轴（坐标轴 2）垂直的平面对称（U2=UR1=UR3=0）。 
 ZSYMM：关于与 Z 轴（坐标轴 3）垂直的平面对称（U3=UR1=UR2=0）。 
 XASYMM：关于与 X 轴（坐标轴 1）垂直的平面反对称（U2=U3=UR1=0），仅适用于

ABAQUS/Standard。 
 YASYMM：关于与 Y 轴（坐标轴 2）垂直的平面反对称（U1=U3=UR2=0），仅适用于

ABAQUS/Standard。 
 ZASYMM：关于与 Z 轴（坐标轴 3）垂直的平面反对称（U1=U2=UR3=0），仅适用于

ABAQUS/Standard。 
 PINNED：约束 3 个平移自由度，即铰支约束（U1=U2=U3=0）。 
 ENCASTRE：约束 6 个自由度，即固支约束（U1=U2=U3=UR1=UR2=UR3=0）。 

2．定义位移/转角边界条件 

在 Create Boundary Condition 对话框中选择 Displacement/Rotation 选项后，单击 Continue 按钮，

选择施加该边界条件的 Point、Line、Surface，单击提示区的 Done 按钮，弹出 Edit Boundary Condition
对话框，如图 2-55 所示。该对话框包括如下选项。 

 CSYS（坐标系）：用于选择坐标系，默认为整体坐标系。单击 Edit 按钮，可以选择局部坐

标系。 
 Distribution（分布方式）：用于选择边界条件的分布方式。 
 U1～UR3：用于指定各个方向的位移边界条件。 
完成边界条件的设置后，单击工具区中的 Boundary Condition Manager（边界条件管理器）图标 ，
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可见 Boundary Condition Manager 内列出了已创建的边界条件。该管理器的用法与载荷管理器类似，

这里不再赘述。 

              
                    （a）铰支约束                              （b）固支约束 

图 2-55  Edit Boundary Condition 对话框 

2.7.3  设置预定义场 

菜单栏中的 Predefined、Field（预定义场）及工具区中的 Create Predefined Field（创建预定义场）

图标 和 Predefined Field Manager（预定义场管理器）图标 用于预定义场的创建和管理。 
执行 Predefined Field（预定义场）→Create 命令，或定义预定义场时，单击工具区中的 Create 

Predefined Field 图标 ，也可双击左侧模型树中的预定义场，弹出 Create Predefined Field 对话框，如

图 2-56 所示。该对话框与 Create Load 对话框类似，包括如下选项。 

            
                       （a）力学类别                        （b）其他类别 

图 2-56  Create Predefined Field 对话框 



 

 
·37·

第 2 章  ABAQUS 的基本模块和操作方法

Note 

 Name：在该文本框中输入预定义场的名称，默认为“Predefined Field-n”（n 表示创建的第 n
个预定义场）。 

 Step：在该下拉列表框内选择用于创建预定义场的步骤，包括初始步和分析步。 
 Category：用于选择适用于所选步骤的预定义场的种类。 

 Mechanical：在初始步中设置速度，如图 2-56（a）所示。单击 Continue 按钮，选择施

加该边界条件的 Point、Line、Surface、Cells，单击提示区的 Done 按钮，弹出 Edit Predefined 
Field 对话框，如图 2-57 所示。 

 Other：包括温度和初始状态、材料指派、饱和、孔隙比、孔隙压力等，如图 2-56（b）
所示，其中初始状态仅适用于初始步，输入以前的分析得到的已发生变形的网格和相

关的材料状态作为初始状态场。 
 Types for Selected Step（可用于所选分析步的类型）：该列表用于选择预定义场的类型，是类

别的下一级选项。 
完成预定义场的设置后，单击工具区中的 Predefined Field Manager（预定义场管理器）图标 ，

弹出 Predefined Field Manager 对话框（见图 2-58），其中列出了已创建的预定义场。该管理器的用法

与载荷管理器、边界条件管理器类似。 

      
     图 2-57  Edit Predefined Field 对话框             图 2-58  Predefined Field Manager 对话框 

2.7.4  定义载荷工况 

菜单栏中的 Load Case（载荷工况）及工具区中第 4 行的 Create Load Case（创建载荷工况）图标

和 Load Case Manager（载荷工况管理器）图标 用于工况的创建和管理。 
工况是一系列组合在一起的载荷和边界条件（可以指定非零的比例系数对载荷和边界条件进行缩

放），线性叠加结构对它们的响应，仅适用于直接求解的稳态动力学线性摄动分析步和静态线性摄动

分析步。定义工况时，执行 Load Case→Create 命令，或单击工具区中的 Create Load Case 图标 ，弹

出 Create Load Case 对话框，如图 2-59 所示。单击 Continue 按钮，弹出 Edit Load Case（编辑载荷工

况）对话框，如图 2-60 所示。 
完成工况的设置后，单击工具区中的 Load Case Manager（载荷工况管理器）图标 ，可见工况

管理器内列出了该分析步内已创建的工况。 
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         图 2-59  Create Load Case 对话框                 图 2-60  Edit Load Case 对话框 

2.8  相互作用模块 

2.8.1  相互作用的定义 

在定义一些相互作用之前，需要定义对应的相互作用属性，包括接触、入射波、热传导、声阻。

本节主要介绍接触属性和接触的定义，其他类型的相互作用请读者参见系统帮助文件。 

1．接触属性的定义 

执行 Interaction→Property→Create 命令，或单击工具区中的

Create Interaction Property（创建相互作用属性）图标 ，弹出 Create 
Interaction Property 对话框，如图 2-61 所示。 

 Name：该文本框中输入相互作用属性的名称，默认为

“IntProp-n”（n 表示创建的第 n 个相互作用属性）。 
 Type：该列表用于选择相互作用属性的类型，包括接触、

膜条件、声学阻抗、入射波、激励器/传感器等。在列表中

选择 Contact 选项，单击 Continue 按钮，弹出 Edit Contact 
Property（编辑接触属性）对话框，如图 2-62 所示。 

Edit Contact Property 对话框包括接触属性选项列表和各种接触

参数的设置区域，下面分别进行介绍。 
 Contact Property Options（接触属性选项）：用于选择接触属性的类型，选择的接触属性会依

次出现在列表中。 
 数据区：出现在接触属性选项的下方，在该区域内设置相应的接触属性值。设置完成后，

单击 OK 按钮。用户可以修改接触属性，方法为：单击工具区中的 Interaction Property Manager
（相互作用属性）图标 ，弹出如图 2-63 所示的对话框，选择需要编辑的接触属性，单击

Edit 按钮；或执行 Interaction→Property→Edit 命令后，在下级菜单中选择需要编辑的接触  
属性。 

图 2-61  Create Interaction 
Property 对话框 
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      图 2-62  Edit Contact Property 对话框              图 2-63  Interaction Property Manager 对话框 

2．接触的定义 

在 ABAQUS/Standard 中，可以定义表面与表面接触、自接触、压力穿透等类型；在 ABAQUS/ 
Explicit 中，可以定义表面与表面接触、自接触、声学阻抗等类型。执行 Interaction→Create 命令，或

单击工具区中的 Create Interaction（创建相互作用）图标 ，弹出 Create Interaction 对话框，如图 2-64
所示。 

         
               （a）Static,General 分析步                  （b）Dynamic,Implicit 分析步 

图 2-64  Create Interaction 对话框 

用户可以通过执行 Interaction→Contact Controls（接触控制）→Create 命令定义接触控制，适用

于 ABAQUS/Standard 和 ABAQUS/Explicit 中的表面与表面接触和自接触。 
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2.8.2  定义约束 

在相互作用模块中，可以使用菜单栏中的约束菜单及工具区

中的 Create Constraint（创建约束）图标 和 Constraint Manager
（约束管理器）图标 进行约束的定义和编辑。 

该模块中的约束是约束模型中各部分间的自由度，而装配模

块中的约束仅仅是限定装配件中各部件的相对位置。 
执行 Constraint→Create 命令，或单击工具区中的 Create 

Constraint 图标 ，弹出 Create Constraint 对话框，如图 2-65 所示。 

2.8.3  定义连接器 

在相互作用模块中，ABAQUS 还允许使用菜单栏中的连接菜

单及工具区中的相应工具进行连接器的定义和编辑。 

 提示：连接器通常用于连接模型装配件中位于两个不同的部件实体上的两个点，或连接模型装配

件中的一个点和地面，来建立它们之间的运动约束关系，也可以选择输出变量并在可视化

模块中进行分析。 

ABAQUS 中的连接器分为已装配连接器、基本信息和 MPC 连接器，其中基础连接器又分为平移

连接器和旋转连接器。 
执行 Connector（连接器）→Section→Create 命令，或单击工具区中的 Create Connector Section（创

建连接器截面）图标 ，弹出 Create Connector Section 对话框，如图 2-66 所示。单击 Continue 按钮，

弹出 Edit Connector Section（编辑连接器截面）对话框，单击 OK 按钮，完成设置。 
单击工具区中的 Create Wire Feature（创建特征线）图标 ，弹出 Create Wire Feature 对话框，在

该对话框中添加 Point 1 和 Point 2，单击 OK 按钮，完成设置，如图 2-67 所示。 

        
    图 2-66  Create Connector Section 对话框              图 2-67  Create Wire Feature 对话框 

完成连接器截面特性的设置和特征线的创建后，可以将已定义的连接器的截面特性分配给指定的

 
图 2-65  Create Constraint 对话框
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连接器（特征线），同时对该连接器划分相应的连接单元。 
执行 Connector→Assignment（指派）→Create 命令，或单击工具区中的 Create Connector Assignment 

（指派连接器属性）图标 ，根据提示选择特征线，弹出 Edit Connector Section Assignment（编辑连

接器截面指派）对话框，如图 2-68 所示。该对话框包含 Section、Orientation l（方位 1）和 Orientation 
2（方位 2）3 个选项卡。 

 Section：用于选择连接器的截面特性，如图 2-68（a）所示。单击 Connection type diagram
（连接类型图表）按钮 时，显示如图 2-69 所示。 

 Orientation 1：用于指定连接器第 1 个端点的坐标系，如图 2-68（b）所示。 
 Orientation 2：用于指定连接器第 2 个端点的坐标系，如图 2-68（c）所示。 

   
（a）Section 选项卡            （b）Orientation l 选项卡           （c）Orientation 2 选项卡 

图 2-68  Edit Connector Section Assignment 对话框 

 
图 2-69  显示图例 

单击 OK 按钮，完成设置，完成连接器截面特性的分配操作。同时 ABAQUS 自动对该连接器划

分单元。 

2.9  网 格 模 块 

2.9.1  定义网格密度 

种子是单元的边结点在区域边界上的标记，它决定了网格的密度。菜单栏中的布种菜单及工具区

中第 1 行的展开工具箱用于模型的布种操作。 
对于非独立实体，在创建了部件后就可以在网格模块中对该部件进行网格划分。进入网格模块后，

首先将环境栏的对象选择为部件，并在部件列表中选择要操作的部件。 
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按住工具区中的 Seed Part Instance（为部件布种）图标 ，在展开工具条 中选择设置种子

的工具，或在菜单栏的布种菜单中进行选择。该展开工具条中的选项说明如下。 
 Seed Part Instance ：对整个部件布种，显示为白色。也可以执行 Seed（种子）→Instance

命令实现该操作。 
 Delete Instance Seeds ：删除使用种子部件工具设置的种子，而不会删除使用为边布种工具

设置的种子。也可以执行 Seeds→Delete Instance Seeds（删除实体种子）命令实现该操作。 
ABAQUS 中也可以通过设置边上的种子对部件进行设置，按住工具区中的 Seed Edge（为边布种）

图标 ，在展开工具条 中选择设置种子的工具，或在菜单栏的布种菜单中进行选择。该展开工

具条中的选项从左到右分别如下。 
 Seed Edges ：为边布种，显示为白色。也可以执行 Seed→Edges 命令实现该操作。 
 Delete Edge Seeds ：删除使用为边布种工具设置的种子，而不会删除使用种子部件工具设

置的种子。也可以执行 Seed→Delete Edge Seeds（删除边上种子）命令实现该操作。 

2.9.2  设置网格控制 

对于二维或三维结构，ABAQUS 可以进行网格控制，而梁、桁架等一维结构则无法进行网格控制。 
执行 Mesh→Controls（控制）命令，或单击工具区中的 Assign Mesh Controls（指派网格控制属性）

图标 ，弹出 Mesh Controls 对话框，如图 2-70 所示。该对话框用于选择单元形状、技术和对应的算

法。 

1．选择单元形状 

对于二维模型，可以选择 Quad（四边形）、Quad-dominated（四边形为主）和 Tri（三角形）3 种

单元形状，如图 2-70 所示。 
对于三维模型，可以选择 Hex（六面体）、Hex-dominated（六面体为主）、Tet（四面体）和 Wedge

（楔形）4 种单元形状，如图 2-71 所示。 

      
            图 2-70  Mesh Controls 对话框                        图 2-71  结构网格技术 

2．选择网格划分技术设置 

在 Mesh Controls 对话框中，可选择的基本网格划分技术有 3 种：Structured（结构）、Sweep（扫

掠）和 Free（自由），如图 2-71～图 2-73 所示。 
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               图 2-72  扫掠网格技术                            图 2-73  自由网格技术 

 提示：对于二维或三维结构，这 3 种网格划分技术拥有各自的网格划分算法。Bottom-up（自底向

上）、As is（保持原状）和 Multiple（重复）3 个选项不是网格划分技术，而是对应于某些

复杂结构的网格划分方案。 

2.9.3  设置单元格类型 

ABAQUS 的单元库非常丰富，用户可以根据模型的情况和分析需要选择合适的单元类型。在设

置了 Mesh Controls 后，执行 Mesh→Element Type（单元形状）命令，或单击工具区中的 Assign Element 
Type（指派单元类型）图标 ，在视图区选择要设置单元类型的模型区域，弹出 Element Type（单元

类型）对话框，如图 2-74 所示。 

 
图 2-74  Element Type 对话框 

 Element Library：用于选择适用于隐式或显式分析的单元库。 
 Geometric Order：用于选择线性单元或二次单元。 
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 Family：该列表用于选择适用于当前分析类型的单元。 
 Element Controls：用于选择单元形状并设置单元控制属性。该对话框默认显示与 Mesh 

Controls 对话框中设置的单元形状一致的页面。 
完成后，单元控制属性栏下端显示出设置的单元的名称和简单描述，单击 OK 按钮。 

2.9.4  划分网格 

完成设置种子、网格控制和单元类型的选择后，就可以对模型进行网格划分了。与种子的设置一

样，网格划分仍然有非独立实体和独立实体的区别，下面主要介绍非独立实体的网格划分。 

 提示：独立实体只需要将环境栏的对象选择为装配，就可以进行类似的操作。 

按住工具区中的 Mesh Part（对部件划分网格）图标 ，在展开工具条 中选择网格划

分的工具，或在菜单栏的网格菜单中进行选择。该展开工具条中的选项说明如下。 
 Mesh Part Instance ：对整个部件划分网格，单击提示区的 Yes 按钮则开始划分，如图 2-75

所示。 

 
图 2-75  提示是否对模型部件划分网格 

 Mesh Region ：对选择的模型区域划分网格。若模型包含多个模型区域，单击该工具，在

视图区选择要划分网格的模型区域，单击鼠标中键，完成该模型区域的网格划分。 
 Delete Instance Native Mesh ：删除整个部件的网格，单击提示区的 Yes 按钮进行部件网格

的删除。 
 Delete Region Native Mesh ：删除模型区域的网格，其操作类似于为区域划分网格工具。 

 提示：若删除或重新设置种子以及重新设置网格控制参数（包括网格划分技术、单元形状、网格

划分算法、重新定义扫略路径或角点、最小化网格过渡等），ABAQUS/CAE 会弹出对话框，

如图 2-76 所示，单击 Delete Meshes 按钮删除已划分的网格，之后才能继续操作。选中

Automatically delete meshes invalidated by seed changes（因种子改变而失效的网格）复选框，

再单击 Delete Meshes 按钮，则以后遇到同样的问题时不再弹出对话框询问，而直接删除网

格。另外，单元类型的重新设置不需要重新划分网格。 

 
图 2-76  询问是否删除网格 

下面通过一个实例说明复杂模型网格划分的两种方式。本例将介绍一个三维模型的网格划分方

法，该模型如图 2-77 所示。 

1．采用四面体单元进行网格划分 

单击工具区中的 Assign Mesh Controls 图标 ，弹出 Mesh Controls 对话框（见图 2-78），在 Element 
Shape 选项组中选中 Tet 单选按钮，单击 OK 按钮，视图区的模型显示为粉红色。 
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图 2-77  实体模型图 

单击工具区中的 Seed Part Instance 图标 ，弹出 Global Seeds（全局种子）对话框（见图 2-79），
在 Approximate global size（近似全局尺寸）文本框中输入“2”，单击 OK 按钮。 

        
              图 2-78  Mesh Cotrols 对话框                    图 2-79  Global Seeds 对话框 

单击工具区中的Assign Mesh Controls图标 ，弹出Element Type对话框（见图 2-80），在Geometric 
Order（几何阶次）选项组中选择 Quadratic（二次），单击 OK 按钮。单击工具区中的 Mesh Part 图标 ，

再单击提示区的 Yes 按钮完成网格划分，划分网格如图 2-81 所示。 

       
图 2-80  Element Type 对话框                         图 2-81  自由网格划分 



 

 
·46·

AABAQUS 2020 有限元分析从入门到精通 

   Note  

模型外表面的网格分布不是很规则，可以考虑在 Mesh Controls 对话框

（见图 2-78）中选中 Use mapped tri meshing on bounding faces where 
appropriate（在边界区域上运用映射网格）复选框，在可以采用映射网格

的边界区域用映射网格划分代替自由网格划分，划分网格如图 2-82 所示。

可见，选用该选项进行网格划分，模型的网格分布都比较规则。 

2．采用六面体单元进行网格划分 

二次六面体单元具有较高的计算精度和效率，因此对于不是特别复杂

的模型可以考虑先分割，再选用二次六面体单元进行结构化或扫略网格划分。 
单击工具区中的 Partition Cell（分割模型区域）图标 ，单击提示区中的 3 个点按钮，在视图区

中选择长方体上表面的 3 个点，单击鼠标中键，将该部件分割为 4 个模型区域。此时 4 个模型区域仍

然继承分割前的种子和网格控制的设置，需要重新设置网格控制和单元类型。 
 单击工具区中的 图标 
在视图区选择分割后的两个模型区域，单击鼠标中键，弹出 Mesh Controls 对话框，在 Element 

Shape 选项组中选中 Hex 单选按钮，Technique（技术）只能选择 Sweep，采用默认的 Medial axis 和
Minimize the mesh transition，单击 OK 按钮，视图区的模型显示为  
黄色。 

 单击工具区中的 图标 
在视图区选择分割后的两个模型区域，单击鼠标中键，弹出

Element Type 对话框，在 Geometric Order 选项组中选中 Quadratic
单选按钮，单元控制栏下端显示 C3D20R（二次减缩积分六面体单

元），单击 OK 按钮。 
 单击工具区中的 图标 
再单击提示区的 OK 按钮完成网格划分，如图 2-83 所示。 

 提示：可以在 Mesh Controls 对话框的 Algorithm（算法）选项组中选中 Advancing front（进阶算法）

单选按钮和 Use mapped meshing where appropriate（运用映射网格）复选框，最终生成如   
图 2-84 所示的体单元。在网格划分完成之前，往往无法预测哪种算法更为合适。 

 
图 2-84  Advancing front 算法划分的六面体网格 

3．协调性 

当对三维模型进行网格划分时，ABAQUS 会首先判断使用设置的网格划分和单元形状方法是否

会在整个模型中生成一个协调的网格。如果能生成一个协调的网格，ABAQUS 继续网格划分；如果

不能生成，视图区高亮度显示不协调的界面，并弹出一个对话框询问读者是否继续划分网格，若继续

单击 OK 按钮，ABAQUS 自动在不协调的界面上产生绑定约束。 

 
图 2-82  映射网格划分

 
图 2-83  Medial axis 算法划分

的六面体网格 
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2.9.5  检查网格 

网格划分完成后，可以进行网格质量的检查。单击工具区中的检查网格工具，或执行 Mesh→Verify
（检查）命令，在提示区选择要检查的模型区域，如图 2-85 所示，包括部件（适用于非独立实体）

或部件实例（适用于独立实体）及单元和几何区域。 

 
图 2-85  选择网格检查的区域 

选择部件、部件实例或几何区域，选择对应的部件实体、部件或模型区域，单击鼠标中键，弹出

Verify Mesh（检查网格）对话框，如图 2-86 所示。下面对该对话框进行介绍。 

          
（a）形状检查                          （b）尺寸检查                    

 
（c）分析检查 

图 2-86  Verify Mesh 对话框 

 Shape Metrics（形状检查）：用于逐项检查单元的形状。单元形状栏列出了选择的模型区域

内的所有单元形状。单击 Highlight 按钮，开始网格检查。检查完毕，视图区高亮度显示不
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符合标准的单元，信息区显示单元总数、不符合标准的单元数量和百分比、该标准量的平

均值和最危险值。单击 Reselect（重新选择）按钮，重新选择网格检查的区域；单击 Defaults
（默认）按钮，使各统计检查项恢复到默认值。 

 Size Metrics（单元检查）：标准栏包括以下 5 种标准。 
 Geometric deviation factor greater than：几何偏差系数大于。 
 Edge shorter than：边短于。 
 Edge longer than：边长于。 
 Stable time increment less than：稳定时间增重小于。 
 Maximum allowable frequency(for acoustic elements)less than：最大允许频率（对声元素）小于。 

 Analysis Checks（分析检查）：用于检查分析过程中会导致错误或警告信息的单元，错误单

元用紫红色高亮度显示，警告单元以黄色高亮度显示。单击 Highlight 按钮，开始网格检查。

检查完毕，视图区高亮度显示错误和警告单元，信息区显示单元总数、错误和警告单元的

数量和百分比。梁单元、垫圈单元和粘合层单元不能使用分析检查。 

2.9.6  提高网格质量 

网格质量是决定计算效率和计算精度的重要因素，可是却没有判断网格质量好坏的统一标准。为

了提高网格质量，有时需要对网格和几何模型等进行调整。本节将介绍提高三维实体模型网格质量的

常用方法。 

1．划分网格前的参数设置 

如前所述，在划分网格前，需要设置种子、网格控制参数和单元类型，这些参数的选择直接决定

三维实体模型的网格质量。参数设置的经验，读者可在应用中慢慢摸索。 

2．编辑几何模型 

有时需要修改或调整几何模型来获得高质量的网格。 
（1）分割模型 
若不能直接用六面体单元对模型划分网格，则可以运用分割工具将其分割成形状较为简单的区

域，并对分割后的区域划分六面体单元。分割工具可以通过工具区或菜单栏中的 Tools→Partition（分

割）命令进行调用，如图 2-87 和图 2-88 所示，包括 4 个分割线的工具、7 个分割面的工具和 6 个分

割体的工具，具体用法不再赘述。 

             
图 2-87  分割按钮工具                  图 2-88  Create Partition 对话框 
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（2）编辑问题模型 
网格的质量不高或网格划分的失败有时是由几何模型的问题（如无效区域、不精确区域、小面、

短边等）引起的。为了获得高质量的网格，需要对有问题的模型进行处理，常用工具包括几何诊断和

几何修复工具，下面将介绍这两种工具。 
 几何诊断工具。首先需要对模型进行几何诊断。单击工具栏中的 Query Information（询问信

息）图标 ，或执行 Tools→Query 命令，在弹出的 Query 对话框中选择 Geometry diagnostics
（几何诊断）选项，如图 2-89 所示，弹出 Geometry Diagnostics 对话框，如图 2-90 所示。该对

话框可用于诊断模型的无效区域、不精确区域、小尺寸区域等。 

                  
                  图 2-89  Query 对话框               图 2-90  Geometry Diagnostics 对话框 

 几何修复工具。通过几何诊断确定模型中的无效区域、小尺寸区域或不精确区域后，可以

在部件模块中选用合适的几何修复工具对模型进行编辑，最终在编辑后的模型上生成高质

量的网格。几何修复工具在 Part 模块中，可以通过工具区或菜单栏中的 Tools→Geometry Edit
命令进行调用，如图 2-91 所示。 

           
    （a）Geometry Edit 命令        （b）Geometry Edit 对话框               （c）按钮工具 

图 2-91  几何修复工具 
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2.10  分析作业模块 

在工具区的模块列表中选择 Job，进入 Job 模块。该模块主要用于分析作业和网格自适应过程的

创建和管理。 

2.10.1  分析作业的创建与管理 

进入作业模块后，菜单栏中的 Job及工具区中第 1行的Create Job（创建作业）图标 和 Job Manager
（作业管理器）图标 ，用于分析作业的创建和管理。 

1．分析作业的创建 

执行 Job→Create 命令，或单击工具区中的 Create Job 图标 ，弹出 Create Job 对话框，如图 2-92
所示。 

该对话框包括以下两个部分。 
 Name：在该文本框中输入分析作业的名称，默认为“Job-n”。 
 Source：该下拉列表框用于选择分析作业的来源，包括 Model 和 Input file（输入文件）。默

认选择为 Model，其下部列出该 CAE 文件中包含的模型，如图 2-92（a）所示，用户需要从

该列表中选择用于创建分析作业的模型。若用户选择输入文件，则可以单击 按钮选择用

于创建分析作业的 INP 文件，如图 2-92（b）所示。 
完成设置后，单击 Continue 按钮，就会弹出 Edit Job 对话框，如图 2-93 所示，可以在该对话框

中进行分析作业的编辑。 

     
（a）Source: Model   （b）Source: Input file 

图 2-92  Create Job 对话框 图 2-93  Edit Job 对话框 
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2．作业管理器 

单击 Job Manager 图标 ，已创建的分析作业出现在作业管理器中，如图 2-94 所示。该管理器中

下部的工具与其他管理器类似，不再赘述，下面介绍 Job Manager 对话框中右侧的工具栏。 
 Write Input：写入输入文件按钮，在工作目录中生成该模型的 INP 文件，等同于在菜单栏中

执行 Job→Write Input（写入输入文件）命令。 
 Submit：用于提交分析作业，等同于在菜单栏中执行 Job→Submit（提交）命令。提交分析

作业后，管理器中的状态栏会相应地改变。 
 Monitor：用于打开分析作业监控器，如图 2-95 所示，等同于在菜单栏中执行 Job→Monitor

（监控）命令。该对话框中的上部表格显示分析过程的信息，这部分信息也可以通过状态

文件（job_name.sta）进行查阅。 

   
图 2-94  Job Manager 对话框                         图 2-95  分析作业监控器 

 Results：用于运行完成的分析作业的后处理，单击该按钮进入可视化模块。该按钮等同于在

菜单栏中执行 Job→Result（结果）命令。 
 Kill：用于终止正在运行的分析作业，等同于在菜单栏中执行 Job→Kill（中断）命令，或分

析作业监控器中的 Kill 按钮。 

2.10.2  网格自适应 

若用户在网格模块定义了自适应网格重划分规则，则可以对该模型运行网格自适应过程。

ABAQUS/CAE 根据自适应网格重划分规则对模型重新划分网格，进而完成一系列连续的分析作业，

直到结果满足自适应网格重划分规则，或已完成指定的最大迭代数，抑或分析中遇到错误。 
单击工具区中的 Create Adaptivity Process（创建网格自适应过程）图标 ，或执行 Adaptivity（自

适应）→Create 命令，弹出 Create Adaptivity Process 对话框，如图 2-96 所示。该对话框与编辑作业对

话框类似，不再赘述。 
设置完成，单击 OK 按钮。 
单击 Adaptivity Process Manager（自适应过程管理器） 图标，已创建的自适应过程出现在管理

器中，如图 2-97 所示。用户可以单击该管理器右侧的 Submit 按钮提交该自适应过程。然而，用户需

要在分析作业管理器中进行自适应过程的监控、终止和每个迭代的结果后处理操作。 
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      图 2-96  Create Adaptivity Process 对话框              图 2-97  Adaptivity Process Manager 对话框 

2.11  可视化模块 

可以通过两种方式进入可视化模块并打开结果数据库文件。 
（1）分析完成后，作业模块的分析作业管理器的状态栏显示

Completed，在管理器中选择要进行后处理的分析作业，单击 Result（结果）

按钮，或在菜单栏中执行 Job→Result 命令，进入可视化模块，视图区显示

该模型的无变形图。 
（2）选择模块列表中的可视化，进入可视化模块，再单击工具栏中的

“打开”按钮 或执行 File（文件）→Open（打开）命令，也可以双击结

果树中的输出数据库，在弹出的 Database 对话框中选择要打开的 ODB 文

件，单击 OK 按钮，视图区将显示该模型的无变形图。 
ABAQUS 的可视化模块用于模型的结果后处理，可以显示 ODB 文件

中的计算分析结果，包括变形前/后的模型图、矢量/张量符号图、材料方向

图、各种变量的分布云图、变量的 X-Y 图表、动画等，以及以文本形式选

择性输出的各种变量的具体数值。这些功能及其控制选项都包含在结果、

绘制、动画、报告、选项和工具菜单中，其中大部分功能还可以通过工具

区中的工具进行调用，如图 2-98 所示。 
下面以一个 ODB 文件为例，对可视化模块中的常用功能进行介绍。 

2.11.1  显示无变形图形和变形图形 

打开 ODB 文件，视图区随即显示该模型的无变形图。用户可以选择显

示模型的变形图，还可以同时显示无变形图和变形图。 

 
图 2-98  可视化模块的

   工具区 
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在可视化模块中打开结果数据库文件后，工具区中的 Plot Undeformed Shape（变形前的网格模型

图）图标 被激活，视图区显示出变形前的网格模型，与网格模块中的网格图相同。 
单击工具区中的 Plot Deformed Shape（绘制变形图）图标 ，或执行 Plot（绘制）→Deformed Shape

（变形图）命令，视图区显示出变形后的网格模型。此时，状态区显示出变形放大系数为 1.0。 

 提示：如果用户直接对模型显示进行截图，则图的背景为黑色。用户可以通过修改背景颜色和打

印输出两种方式得到白色背景。 

 修改背景颜色。执行 View（视图）→Graphics Options（图形选项）命令，弹出 Graphics Options
对话框，如图 2-99 所示，单击视口背景栏内实体后的色标，在弹出的 Select Color（选择颜

色）对话框（见图 2-100）中选择白色，单击 OK 按钮，返回 Graphics Options 对话框，单

击 Apply 按钮，视图区的背景变为白色。用户也可选择渐变并编辑渐变的背景。 

           
      图 2-99  Graphics Options 对话框                    图 2-100  Select Color 对话框 

 打印输出。执行 File→Print（打印）命令，弹出 Print 对话框，在目标栏中选择文件，在文

件名称栏中输入文件名，单击 OK 按钮选择保存图片的文件夹，在格式栏中选择文件格式，

单击 Apply 按钮，保存背景为白色的图片。 

2.11.2  绘制云纹图 

云图用于在模型上用颜色显示分析变量。执行 Plot→Contours（云纹图）→On Deformed Shape（在变

形图上）命令，或单击左侧工具区中的 Plot Contours On Deformed Shape（在变形图上绘制云纹图）

图标 ，视图区显示模型变形后的 Mises 应力云纹图。 
按住工具区中的 图标，在展开的工具条 中可以选择云图的显示方式，后两项分别为显

示在变形前模型上的云纹图和显示在变形后模型上的云纹图。 

 提示：该功能也可以在菜单栏的 Plot→Contours 命令中选择。 

执行菜单栏中的 Viewport（视图）→Viewport Annotation Options（视图注释选项）命令，可以在

弹出的 Viewport Annotation Options 对话框中进行坐标轴、图例、标题、状态信息等的设置，General
选项卡用于控制它们在视图区的显示，其他 4 个选项卡分别用于它们的设置，如图 2-101 所示。 
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图 2-101  Viewport Annotation Options 对话框 

2.12  本 章 小 结 

ABAQUS 的所有功能都集成在各模块中，用户可以根据需要在 ABAQUS/CAE 主界面中激活各

模块，对应的菜单和工具栏随即出现在界面中。 
ABAQUS 的模型是基于 CAD 软件中的部件和组装的概念建立起来的。ABAQUS 的模型包括一

个或多个部件，所有部件都在部件模块中建立，部件的草图在草图模块中创建，各部件在装配模块中

进行组装，属性模块用于定义材料属性和截面特性。 
随后，需要进入分析步模块进行分析步和输出的定义，也可以进行求解控制和自适应网格划分的

设置。在载荷模块施加载荷和边界条件及在相互作用模块定义接触前，需要创建分析步，选择在初始

步或是分析步中设置接触和边界条件，载荷则只能设置在分析步中。然后在网格模块划分网格，作业

模块提交作业，最后在可视化模块观察结果。 
本章详细介绍了各个模块的功能，读者可以多加练习，并进一步在后面章节的学习中加以巩固。 
 




